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tillstånd från Nox Medical. 

Friskrivningsklausul 

Detta dokument kan innehålla typografiska fel eller tekniska felaktigheter. Nox Medical tar inget ansvar för 

användning eller felaktig användning, vare sig direkt eller indirekt, av produkterna, eller för skador som 

uppstår på grund av användning eller oförmåga att använda produkterna. Användaren måste ta hela ansvaret 

för varje resultat som erhålls genom eller som härrör från data som erhållits med produkter, inklusive 

programvara, från Nox Medical. Alla kliniska slutsatser och beslut som baseras på användning av denna 

produkt är användarens ansvar. 
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Inledning 

Grattis till ditt val av Noxturnal®-programmet. Noxturnal-programmet är en modern 

programvaruplattform för sömndiagnostik som är utformad att vara enkel att använda och fungera 

effektivt. Dess huvudfunktion är att arbeta med registrerade data från registreringsenheter från Nox 

Medical (se kapitlet Registreringsenheter som stöds) och leda användaren genom arbetsflödet att 

konfigurera registreringar, ladda ned data, analysera och rapportera. 

Avsedd användning 

Noxturnal-programmet (programvaran) interagerar med Nox sömnregistreringsenheter och Nox C1 

åtkomstpunkt för styrning. Noxturnal stödjer både ambulatoriska och onlinesömnstudier. Noxturnal 

används för att granska såväl ambulatoriska studier som signaler som spelats in i realtidstillämpning. 

Onlinetillämpningar som stöds är antingen A1 registreringsenhet via Bluetooth-anslutningspunkt eller 

A1 registreringsenhet med Nox C1 åtkomstpunkt. Programmet används för navigering, analys och 

arkivering av dessa signaler och studier, och kan utföra automatisk analys och skapa analysrapporter.  

Noxturnal är avsett att användas för patienter över 2 år. 

Avsedda miljöer är sjukhus, institutioner, sömncenter, sömnkliniker eller andra testmiljöer. 

Kontraindikationer 

Noxturnal-programmet är INTE avsett för patientövervakning eller automatiserad diagnos. 

Omfattning 

Denna handbok täcker Noxturnal-programmet. Den täcker inte Nox registreringsenheter och dessas 

tillbehör som behövs för att registrera fysiologiska signaler. 

Varningar och försiktighetsåtgärder  

 Varning: Nox registreringssystem är INTE CERTIFIERADE ATT ANVÄNDAS FÖR KONTINUERLIG 

ÖVERVAKNING där bristande funktion kan orsaka skador eller dödsfall för patienten. 

 Varning: Nox registreringssystem är endast avsedda att vara ett hjälpmedel vid bedömningen 

av en patient. De måste användas tillsammans med andra metoder för att bedöma kliniska 

tecken och symptom. 

 Varning: Automatiska analyser i Noxturnal, särskilt analyser som beräknar hjärtfrekvens och 

andningsfrekvens från underliggande EKG- och andningsförsökssignaler har inte validerats för 

patienter med diafragmapacing/stimulatorer för nervus phrenicus. 

 Varning: Tryckkolumnen i PAP-översiktssektionen av PAP-rapporten och PSG PAP-rapporten 

visar masktrycket i motsvarande enhet och INTE inställt tryck på enheten. 

 Försiktigt: Enligt federala lagar i USA får denna enhet endast säljas av eller på order av läkare. 

 Varning: Nox registreringsenheter får under inga omständigheter anslutas till USB-porten 

medan de är anslutna till patienten. Detta kan leda till elektrisk stöt för patienten och orsaka 

skada. 
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 Läs denna handbok noga före användningen, särskilt de avsnitt som är 

markerade med ett utropstecken. 
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Beskrivning av programmet 

Noxturnal-programmet interagerar med Nox sömnregistreringsenheter och C1 åtkomstpunkt. Den gör 

det möjlighet att konfigurera enheterna samt: navigera, analysera, rapportera och arkivera 

registrerade data från enheterna. I detta avsnitt beskrivs programmets huvudfunktioner och 

installationsinstruktioner. 

Registreringsenheter som stöds 

Noxturnal stödjer följande registreringsenheter och tillhörande länkade enheter och tillbehör: 

 Nox A1 PSG-registreringsenhet 

 Nox T3 sömnregistreringsenhet 

 Nox C1 åtkomstpunkt 

Installera Noxturnal  

Granska systemkraven för att köra tillämpningen innan du installerar Noxturnal-programmet. 

Systemkrav för Noxturnal 

I följande tabell visas de minsta hårdvarukrav som behövs för att installera och köra programmet på 

ett effektivt sätt. 

 

 Den dator som används måste uppfylla den internationella standarden IEC 

60950-1 för säkerhet för informationsteknisk utrustning. 

 Det rekommenderas att virusskydd installeras på den dator där Noxturnal körs. 

Minsta systemkrav 

Hårdvarutyp Minimikrav 

Operativsystem Windows® Vista 

Processor X86-baserad Intel eller AMD 

Processorns klockfrekvens 1,7 GHz eller snabbare 

Minne Minst 1 GB 

Ledigt utrymme på hårddisken Minst 500 MB 

Grafisk upplösning 1024x768 eller högre 

För inställning med onlinesystem gäller samma minimikrav för systemet som ovan. Det 

rekommenderas bestämt att en separat dator används för varje onlinesystem. För expertanvändare är 

det emellertid möjligt att köra mer än ett system på en och samma dator. Hårdvarukraven för en 

sådan inställning är som följer. 

Hårdvarutyp Minimikrav 

Processor Intel core i7 quad core eller högre ELLER kompatibel AMD 

RAM  
Hårddisk  

Minst 16 GB 

Minst 512 GB 
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Installationsinstruktioner 

 Se till att du är inloggad i systemet med administratörsbehörighet. 

 Sök efter en fil på installationsskivan med namnet Setup.exe och kör den. 

 En guide öppnas som leder användaren genom installationen. Följ instruktionerna för att 

installera programmet. 
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Standardanvändning 

För att köra Noxturnal-programmet dubbelklickar du på ikonen på skrivbordet eller klickar på 

programmets ikon i Windows startmeny. För att stänga programmet kan du antingen klicka på X i det 

övre högra hörnet eller välja Exit (Avsluta) i menyn File (Arkiv). 

När Noxturnal startar visas arbetsmiljön. Om du har en ansluten enhet ser du den på bilden, annars 

visas ingen enhet. För detta dokument har vi haft en Nox T3-registreringsenhet ansluten och denna 

visas på bilden. 

 

Fönstret Recording (Registrering) är det ställe där användaren arbetar med Nox-enheterna och 

registrerade data. Detta fönster guidar användaren genom programmets vanligaste åtgärder.  Dessa 

är: 

 Library (Bibliotek): I det övre vänstra hörnet ser du detta alternativ. Detta alternativ öppnar 

registreringsbiblioteket. Där finns en lista över alla registreringar som antingen har laddats 

ner eller lagts till manuellt till registreringsbiblioteket. Se avsnittet Registreringsbiblioteket 

för mer information. 

 Configure Device (Konfigurera enheten): Välj detta alternativ för att starta en ny 

ambulatorisk registrering. En konfigurationsguide öppnas som leder användaren genom 

konfigurationsprocessen. Se avsnittet Starta en ny ambulatorisk registrering för mer 

information. 

 Download Recording (Ladda ned registrering): Om en registreringsenhet är ansluten och 

innehåller en registrering kan användaren ladda ned och granska registreringen. Se avsnittet 

Ladda ned en ambulatorisk registrering från en Nox registreringsenhet för mer information.  
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För att konfigurera en onlineregistrering måste ett onlinerum vara förkonfigurerat och visas på sidan 

Recording (Registrering) och vara valbart. Instruktioner för hur du konfigurerar en onlineregistrering 

finns i avsnittet Inställning av Nox A1-systemet för onlineregistreringar. 

Ansluta en Nox registreringsenhet til l Noxturnal  

Noxturnal används för att konfigurera och ladda ned registrerade data från Nox registreringsenheter. 

För att arbeta med en registreringsenhet börjar du med att ansluta den med en USB-kabel till datorn. 

Noxturnal känner automatiskt av enheten och visar information om den. Detektionen kan ta 2–4 

sekunder. 

När Noxturnal upptäcker den anslutna enheten visas följande information om enheten: 

registreringsstatus, fast programvaruversion och enhetens namn.  

Vilka uppgifter som utförts på registreringsenheten beror på enhetens status, som kan vara följande: 

 Empty  (Tom) – Enheten har inte konfigurerats och innehåller inte några registreringar. Klicka 

på Configure Device (Konfigurera enhet) för att konfigurera enheten för en ny registrering. 

Notera att om du konfigurerar enheten kommer eventuella befintliga registreringar tas bort 

från enheten. 

 Ready to Record  (Klar för registrering) – Enheten har konfigurerats, men innehåller inte 

några registreringar. Användaren kan nu koppla ifrån enheten och inleda 

registreringsprocessen. 

 Ready to Download (Klar för nedladdning) – Enheten innehåller en registrering som inte har 

laddats ned till datorn. Klicka på knappen Download Recording (Ladda ned registrering) för 

att ladda ned registreringen till datorn. 

 Download Complete (Nedladdning klar) – Enheten innehåller en registrering som redan har 

laddats ned och lagts till i registreringsbiblioteket. Användaren kan nu antingen klicka på 

Configure Device (Konfigurera enhet) för att konfigurera enheten för en ny registrering eller 

klicka på Download Recording (Ladda ned registrering) för att ladda ned registreringen igen. 

När du är klar med att arbeta med enheten klickar du på länken Eject (Mata ut) och kopplar bort 

enheten från datorn. 

 

 Notera att även om det rekommenderas att registreringsenheten matas ut 

innan den kopplas bort från datorn, så går det att koppla bort den utan att först 

mata ut. 

Uppgradera registreringsenhetens programvara 

Om en ny version av programvaran finns tillgänglig för den ansluta enheten kommer Noxturnal att 

informera användaren om detta genom att visa en tipsbubbla bredvid enheten. Detta beteende är 

oberoende av enhet, och du kommer att se typen av enhet i fönstret, beroende på vilken enhet du 

har anslutit. På den här bilden har vi en Nox T3 registreringsenhet ansluten. 
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Du kan antingen välja att ignorera meddelandet och fortsätta arbeta eller att uppgradera enhetens 

programvara, vilket alltid rekommenderas. För att uppgradera klickar du på bubblan och följer sedan 

de instruktioner som visas. 

 

 Efter att du klickat på bubblan för att uppgradera måste du koppla bort 

registreringsenheten från datorn och återansluta den igen för att 

programuppgraderingen ska ske. 

 Det rekommenderas alltid att du utför programuppgraderingen för att se till att 

Nox registreringsenhet körs med den senaste programversionen. Nya 

programversioner kan innehålla viktiga programuppdateringar för driften av 

registreringsenheten.  
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Starta en ny ambulatorisk registrering  

För att förbereda en registreringsenhet för en ny registrering startar du Noxturnal-programmet och 

ansluter enheten till datorn med en USB-kabel. Noxturnal känner automatiskt av enheten och visar 

information om den på sidan Recording (Registrering). Klicka på knappen Configure Device 

(Konfigurera enhet) på sidan Recording (Registrering) så öppnas en guide som leder användaren 

genom enhetens konfigurationsprocess. 

Konfigurationsguiden är enhetsberoende. Detta innebär att konfigurationsguiden kommer att variera 

beroende på vilken typ av Nox registreringsenhet som konfigureras. De viktigaste stegen är emellertid 

alltid desamma: 

1.) Konfiguration av enheten. Här väljer du vilken registreringstyp som ska 

användas (vilka tillbehörsenheter som kan anslutas och vilka kanaler som ska 

registreras) 

2.) Schemaläggning av registrering. Här kan du välja vilken tidpunkt och datum en 

registrering ska startas eller låta patienten starta registreringen själv. 

3.) Patientinformation. Här lägger du till den patientinformation som behövs till 

registreringen. 

I denna handbok visas konfigurationsguiden för Nox T3 registreringsenhet. Det första steget är att 

definiera vilken registreringstyp som ska användas vid registreringen. Registreringstyperna har 

beskrivande namn som visar vilka registreringar de används för. 

Se avsnitten Registreringstyper och Enhetsprofiler för mer information om hur man skapar och 

redigerar olika registreringstyper och enhetsprofiler. 
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Om din registreringstyp är inställd för att registrera data från en Bluetooth-enhet, t.ex. en 

pulsoximeter, ser du det i konfigurationsguiden. För att en Bluetooth-enhet ska kunna användas 

måste den vara kopplad till registreringsenheten. Ange lämpligt Pin-PDA-nummer för oximetern i 

relevant fält i konfigurationsguiden.  

Klicka på Next (Nästa) för att fortsätta till steg två, där du schemalägger registreringstiden. 

  

 Om alternativet Manually Start Recording (Starta registrering manuellt) är markerat är 

användaren ansvarig för att starta/stoppa registreringen från registreringsenheten. Detta 

görs genom att trycka på och hålla in mittknappen på enheten tills enhetens bildskärm visar 

att registreringen har börjat. 

 Markera alternativet Start Recording At: (Starta registrering kl.) för att schemalägga en 

specifik registreringstidpunkt. Enheten slår på sig själv och startar automatiskt registreringen 

vid angiven tidpunkt. Om användaren väljer att registrera under mer än en natt kommer 

varje registrering att starta vid samma tidpunkt varje kväll. 

 För att stoppa registreringen efter en viss varaktighet kan du specificera att Duration 

(Varaktigheten) ska vara antingen: 7 Hours (7 timmar), 8 Hours (8 timmar), 10 Hours (10 

timmar) eller ange en anpassad varaktighet. Om du väljer Unspecified (Ospecificerad) är 

användaren ansvarig för att stoppa registreringen. Detta görs genom att trycka på och hålla 

in mittknappen på enheten tills enhetens bildskärm visar att registreringen har stoppats. 

Klicka på Next (Nästa) för att gå vidare till det tredje steget, dialogrutan för patientinformation. I 

denna dialog kan du ange detaljerad information om patienten. De enda fält som är obligatoriska är 

patientnamnet eller patient-ID.  
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Efter att du har angett patientinformationen klickar du på Finish (Slutför) för att lagra konfigurationen 

i enheten. 

När du har tryckt på Finish (Slutför) är enheten konfigurerad. Om det finns en registrering i enheten 

blir användaren tillfrågad om denna registrering ska raderas från registreringsenheten. 
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Slutligen visas en bekräftelsesida som visar att enheten har konfigurerats. För vissa 

registreringsenheter (t.ex. Nox T3) kan anslutningsinstruktionerna skrivas ut genom att klicka på 

knappen Print Hookup Instructions (Skriv ut anslutningsinformation). Ett pdf-dokument med 

kopplingsschemat öppnas och kan skrivas ut. Om det inte finns några anslutningsinstruktioner visas 

inte detta alternativ. 

  

Registreringstyper 

Noxturnal erbjuder ett antal olika registreringstyper som är tillgängliga för konfiguration av både 

ambulatoriska och onlineregistreringar. Registreringstyperna omfattar den enhetskombination som 

ska användas för olika typer av sömnstudier samt enhetsinställningarna. Registreringstyperna 

definierar också automatiseringen av olika registreringar, relevant layout på arbetsytan, analyser och 

rapporterna som ska användas för registreringen. I Noxturnal kan du enkelt skapa egna 

registreringstyper för att styra vilka enheter och inställningar som ska användas för registreringarna. 

Följ dessa steg för att skapa en egen registreringstyp.  

1. Välj den Nox registreringsenhet som du skapar en registreringstyp för och ange om den är 

avsedd för ambulatoriska eller onlineregistreringar. 

2. Ställ in att registreringstypen ska omfatta tillämplig layout på arbetsytan, analys och rapport 

samt vilka enheter och enhetsprofiler som ska användas. 

Registreringstypguiden är enhetsberoende. Detta innebär att guiden kommer att variera beroende på 

vilken typ av Nox registreringsenhet som konfigureras. De viktigaste stegen är emellertid alltid 

desamma: 

1. Från Verktygsfältet i Noxturnal navigerar du till Devices (Enheter) > Recording Types...  

(Registreringstyper...) 
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Registreringstypguiden öppnas. 

 

Här kan du välja New, en ny registreringstyp, New Based On, en ny registreringstyp baserad på en av 

de tillgängliga registreringstyperna samt Edit (Redigera) eller Remove (Ta bort) för anpassade 

registreringstyper. I detta exempel kommer vi att skapa en ny registreringstyp för Nox T3-enheten.  
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1. Välj registreringstypen Nox T3 (ambulatory) (Nox T3 (ambulatorisk)) i listrutan på det sätt 

som visas nedan. 

 

2. Nästa steg är att ställa in registreringstypen. I följande guide kan du ställa in din 

registreringstyp.  
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3.  Ange registreringstypens namn i fältet Recording Type Name och en beskrivning av 

registreringstypen i fältet Description. Välj tillämplig Workspace Layout (Arbetsytans layout), 

Analysis  (Analys) och Report (Rapport). Du har också möjlighet att lägga till tilläggsenheter. 

Välj till exempel Nonin 3150 (under Device Types (Enhetstyper)) och klicka på Add>> (Lägg 

till). 

 

 

 

 

 

 

 

 

 

 

 

 

Notera att det också går att välja tillämplig Device Profile (Enhetsprofil) för denna registreringstyp 

direkt i registreringstypguiden, se nedan. 
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Du kan också skapa anpassade enhetsprofiler. Följ instruktionerna i avsnittet Enhetsprofiler för 

ytterligare instruktioner. Så snart du har skapat en ny enhetsprofil visas den i listrutan i 

registreringstypguiden. 

När du har gjort inställningarna för din registreringstyp klickar du på OK så blir din anpassade 

registreringstyp tillgänglig för konfiguration.  

Enhetsprofiler  

Enhetsprofilerna har skapats för alla standardregistreringar som du kan vilja göra med Nox 

registreringsenheter. De gör det enkelt att göra inställningar under enhetens konfigurationsprocess. 

Från Verktygsfältet i Noxturnal navigerar du till Devices (Enheter) > Device Profiles… 

(Enhetsprofiler...) 

 

I enhetsprofilguiden kan du se en lista över tillgängliga enhetsprofiler för Nox registreringsenheter och 

Nox C1. 
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För att skapa en anpassad enhetsprofil väljer du New (Ny) eller New Based On (Ny baserad på). 

Därefter måste du välja för vilken registreringsenhet mallen är avsedd eller vilken av de befintliga 

enhetsprofilerna du vill basera din nya mall på. I detta exempel kommer vi att skapa en ny 

enhetsprofil för Nox T3. 

 



 

   

~ 21 ~ 

I profilegenskapsguiden kan du göra inställningar för enhetsprofilen. Ange namnet i fältet Name (och 

en beskrivning om du vill).  

 

Klicka på Next (Nästa) för att gå vidare till nästa steg. 

I nedanstående dialog kan du göra inställningar för enhetens kanalkonfiguration. Dialogen Configure 

Device (Konfigurera enhet) är enhetsberoende. Detta innebär att guiden kommer att variera 

beroende på vilken typ av Nox-enhet som används. När du har ställt in kanalkonfigurationen klickar 

du på Next (Nästa). 
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Det sista steget är att definiera vilken batterityp som ska användas för din registreringsenhet. Välj 

tillämplig batterityp och klicka på Finish (Slutför). 

 

Den enhetsprofil du skapade finns nu i listan över enhetsprofiler och är tillgänglig för konfiguration.  

 
 Enhetsprofilguiderna varierar mellan olika Nox registreringsenheter 

Ladda ned en ambulatorisk registrering från en Nox registreringsenhet  

För att ladda ned registrerade data från en registreringsenhet till datorn, kontrollera att Noxturnal 

körs och anslut sedan en enhet till en USB-port på datorn. 

Noxturnal känner automatiskt av enheten och visar information om den på sidan Recording 

(Registrering). Detektionen kan ta 2–4 sekunder. 

Klicka på knappen Download Recording (Ladda ned registrering) på sidan Recording (Registrering) så 

börjar Noxturnal ladda ned registreringen från enheten till datorn. En dialog som visar 

nedladdningens förlopp öppnas och visar de steg som utgör nedladdningen. Data laddas först ned och 

sedan körs det förvalda analysprotokollet och därefter, om enheten har konfigurerats för att 

registrera ljud, startar ljudnedladdningen. Det går att börja bearbeta dessa data när som helst medan 

de laddas ned genom att klicka på länken Start Working (Börja arbeta). 
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När nedladdningen är klar informeras användaren om detta och kan börja arbeta med hela 

registreringen. 

Registreringarna laddas alltid ned till den förvalda datalagringsplatsen. Det går att ändra förvald 

datalagringsplats på automatiseringsfliken i dialogen för verktygsalternativ (Tools → Settings… → 

General (Verktyg → Inställningar... → Allmänt)). Nedladdade registreringar läggs automatiskt till i 

registreringsbiblioteket och kan granskas när som helst genom att gå till registreringsbiblioteket och 

öppna dem. Se avsnittet Registreringsbiblioteket för mer information.  

 

 Om en nedladdning misslyckas delvis av någon orsak kan detta leda till osäkra 

registreringsresultat. Användaren blir varnad när detta inträffar och måste då 

besluta om registrerade data är kompletta eller inte. Det går att ladda ned data 

från enheten på nytt. 

 Den nedladdade registreringen raderas inte från enheten förrän enheten 

konfigureras för en ny registrering. 
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Inställning av Nox A1-systemet för onlineregistreringar  

Översikt över nätverk för onlinesystem 

För att säkerställa stabil drift av onlinefunktionen i Nox A1-system, följ de rekommenderade 

systeminställningarna nedan.  

 Det rekommenderas att en separat dator används för varje onlinesystem. Det är emellertid 

möjligt att köra mer än ett system på en och samma dator, se avsnittet Minsta systemkrav 

för mer information.  

 Använd ett separat lokalt nätverk (LAN) för varje Bluetooth-åtkomstpunkt (Nox C1 

åtkomstpunkt eller BlueGiga) och en dator som kör Noxturnal-programmet. 

 Använd en separat Bluetooth-åtkomstpunkt för varje Nox A1 registreringsenhet som ska 

användas. 

I nedanstående tabell beskrivs inställningen i det kontrollrum där datorn med Noxturnal installerad är 

placerad.  

Kontrollrum 

Objekt Anslutning 

Dator 
Ansluten till samma nätverk som Nox C1 med 

en nätverkskabel 

Noxturnal Installerad på datorn 

I nedanstående tabell beskrivs inställningen i patientrummet där patienten sover under en 

sömnstudie. 

Patientrum 

Objektets namn Beskrivning Funktion Inställning/anslutning 

Nox C1 
åtkomstpunkt 

Bluetooth-
åtkomstpunkt med 
analoga och seriella 
ingångar och inbyggd 
ljussensor och 
differentialtrycksensor 

Kommunicerar med Nox 
A1 med hjälp av 
Bluetooth via Ethernet: 
 Dataöverföring från 

Nox A1 till Noxturnal 
 Kommandon från 

Noxturnal till Nox A1 
 Dataöverföring från 

anslutna 
kringutrustningar 
anslutna till seriell 
eller analog kanal 

Placerad i 
patientrummet. 
Ansluten till samma 
LAN som datorn där 
Noxturnal-
programmet körs 

BlueGiga 
Bluetooth-
åtkomstpunkt 

Kommunicerar med Nox 
A1 med hjälp av 
Bluetooth via Ethernet: 
 Dataöverföring från 

Nox A1 till Noxturnal 
 Kommandon från 

Noxturnal till Nox A1 

Placerad i 
patientrummet. 
Ansluten till samma 
LAN som datorn där 
Noxturnal-
programmet körs 
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Nox A1-
registreringsenhet 
och tillämpliga 
sensorer 

PSG-
sömnregistreringsenhet 

Registrerar fysiologiska 
signaler från anslutna 
sensorer 

Ansluten till patienten 
i patientrummet 

Medicinska 
externa enheter 

Varje medicinsk enhet 
som uppfyller 
specifikationerna för 
ingående kanal för Nox 
C1-enheten eller kan 
anslutas till A1 via 
Bluetooth 

Beror på vilken extern 
utrustning som används 

Tillämplig 
anslutningskabel 
ansluten till 
analog/seriell/USB-
ingång på Nox C1-
enheten eller via 
Bluetooth 

I nedanstående figur visas en översikt över inställningen av Nox A1 onlinesystem.

 

Bluetooth-åtkomstpunkterna (Nox C1 åtkomstpunkt eller BlueGiga) styrs av Noxturnal-programmet.  

Se handböckerna för Nox C1 och Nox A1 för ytterligare instruktioner om Nox C1 åtkomstpunkt och 

Nox A1-enheten. 
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Konfiguration av onlinesystem 

Nox A1 registreringsenhet stödjer onlineregistrering av signaler. För att göra den här typen av 

registreringar behöver du en licens för Noxturnal A1 onlineregistrering som är aktiv på din dator samt 

en Bluetooth-åtkomstpunkt (Nox C1 åtkomstpunkt eller BlueGiga). Kontakta Nox Medical eller deras 

representanter för mer information om detta. I detta avsnitt beskrivs hur du ställer in Nox A1 

onlinesystem och utför onlinestudier i Noxturnal.  

Kontrollera först att du har ställt i ordning alla tillbehör som behövs, t.ex. Nox C1 åtkomstpunkt, 

Ethernetkablar och switch. Se handboken för Nox C1 för mer information om hur du ska ställa in ditt 

nätverk, inklusive Nox C1 åtkomstpunkt.  

För att ställa in systemet i Noxturnal måste du utföra följande steg, efter vad som är tillämpligt: 

1. Ställa in onlinerum 

2. Konfigurera nya sensorer 

3. Ställa in enhetsprofiler 

4. Ställa in registreringstyper 

Dessa steg beskrivs nedan. Genom att följa dessa steg kommer du att kunna starta din 

onlineregistrering och sedan börja arbeta med signalerna i Noxturnal. 

Onlinerum 

Att ställa in ett onlinerum är en del av att ställa in Noxturnal för onlineregistreringar. Onlinerummet 

innehåller ett antal enheter som man normalt har tillsammans i ett rum. Det kan till exempel vara all 

de enheter som du har i ett visst sjukhusrum som är dedikerat för sömnstudier.  

För att lägga till ett nytt rum väljer du Devices > Online Rooms… (Enheter > Onlinerum...) från 

verktygsfältet i Noxturnal. Då öppnas dialogen Rooms (Rum). 

 



 

   

~ 27 ~ 

 

Här kan du lägga till ett nytt rum eller redigera ett befintligt rum. För att lägga till ett nytt rum klickar 

du på Add Room (Lägg till rum). I dialogen nedan kan du ge det nya rummet ett namn genom att 

klicka på pennikonen och lägga till enheter till ditt rum genom att klicka på Add Devices (Lägg till 

enheter). 
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I guiden Add Devices (Lägg till enheter) kan du lägga till enheter till ditt rum. För att lägga till en enhet 

väljer du önskad enhet i listan Device Types (Enhetstyper) och klickar på Add>> (Lägg till>>), eller 

dubbelklickar på enheten i listan. Du kan söka efter anslutna IP-enheter i nätverket genom att klicka 

på Scan for IP Devices (Skanna efter IP-enheter). 

 

När du lägger till en Nox A1 registreringsenhet kommer du att behöva välja tillämplig åtkomstpunkt 

som används i rummet och klicka på Scan (Skanna) för att söka efter din Nox A1 registreringsenhet 

eller ange A1-enhetens serienummer manuellt. Kom ihåg att ha registreringsenheten påslagen under 

detta steg. Välj din registreringsenhet i listan och klicka på Next (Nästa).  
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När du har lagt till ett urval av enheter i samlingen av tillgängliga enheter kan du välja de enheter du 

vill lägga till i ditt onlinerum.  

 

För att välja enheter att lägga till i ditt rum klickar du på enheten. En tjock blå ram visas runt varje vald 

enhet. När du har valt de enheter du vill lägga till i rummet klickar du på Add to Room (Lägg till i 

rummet), så läggs ditt rum med detta urval av enheter till. 
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Du har nu slutfört konfigurationen av onlinerummet. På samma sätt kan du lägga till fler rum.  

Konfigurera nya sensorer 

Om du vill skapa nya sensorkonfigurationer, t.ex. för att använda med Nox C1, kan du göra det genom 

att gå till Devices > Sensors… (Enheter > Sensorer) från verktygsfältet i Noxturnal. 

   

Från guiden Manage Sensors (Hantera sensorer) kan du skapa en ny sensor och redigera/radera 

befintliga sensorer. För att skapa en ny patient- eller extern sensor klickar du på New (Ny).  
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Du kan välja om du vill skapa en ny patientsensor eller en extern sensor. Fyll i tillämpliga fält och klicka 

på OK för att spara sensorkonfigurationen. 

Enhetsprofiler för onlineenheter 

För Nox-enheter som används för onlineregistreringar (Nox A1 (online) och Nox C1) kan du ställa in 

enhetsprofiler. Enhetsprofilerna består av enhetens kanalkonfiguration. Noxturnal erbjuder ett antal 

standardenhetsprofiler, och du kan också enkelt skapa nya enhetsprofiler. Instruktioner för hur du 

anpassar enhetsprofiler finns i avsnittet Enhetsprofiler. 

Registreringstyper för onlineenheter  

Det sista steget är att ställa in registreringstyper. Det är en lista över olika typer av registreringar som 

du vill registrera online på din klinik. Varje registreringstyp är en sammanställning av tillgängliga 

onlineenhetstyper som kan grupperas tillsammans. Exempel: Standard-PSG med Nox C1 är en 

sammanställning av Nox C1 åtkomstpunkt, Nox A1 registreringsenhet, Nonin 3150 oximeter samt en 

videokamera. Instruktioner för hur du ställer in nya registreringstyper finns i avsnittet 

Registreringstyper. 

Starta en onlineregistrering 

När du har genomfört ovanstående steg för att ställa in din onlinekonfiguration kan du starta en 

onlineregistrering. Från sidan Recording (Registrering) kan du starta en onlineregistrering i det rum du 

har skapat. För att starta registreringen kan du antingen dubbelklicka på rummets ikon eller klicka på 

Configure Recording (Konfigurera registrering). 
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Då öppnas guiden Start Online Recording (Starta onlineregistrering). Med denna guide kan du: 

 Välja vilken registreringstyp som ska utföras i listrutan. 

 Valet av enheter beror på vilken registreringstyp som väljs. Alla enheter som är 

tillgängliga i onlinerummet visas i listan, men enheter som inte ingår i registreringstypen 

är gråtonade. Du kan inkludera de inaktiverade enheterna i registreringen genom att 

markera tillämpliga rutor i listan över enheter. 

 Välj Device Profile (Enhetsprofil) för vissa enheter, t.ex. Nox A1 och Nox C1. 
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När du har valt Recording Type (Registreringstyp) och korrekta enheter med enhetsprofiler kan du 

klicka på Next (Nästa) för att ange patientinformationen. Det sista steget är att starta registreringen. 

Detta gör du genom att klicka på Start Recording (Starta registrering) i guiden Patient Information 

(Patientinformation).  

Då ser du din valda layout för arbetsytan med ett statusfönster som visar status på den registrering 

som ska starta. Slutligen ser du de registrerade signalerna i realtid och kan börja arbeta med dem. 

Konfiguration av Nox C1 

Nox C1-enheten är utrustad med 12 analoga kanaler som är lämpliga för att samla in likströmssignaler 

från externa utrustningar. Kanalerna är samlade på 6 portar, märkta DC IN från 1 till 12 högst upp på 

enheten. Varje analog port ger 2 kanaler. Externa enheter kan anslutas till de analoga ingångarna på 

Nox C1. Spänningsområdet medger gränssnitt mot signaler från -5 V till +5 V. Mer information om Nox 

C1 finns i handboken för Nox C1.  

Nätverkskonfiguration av Nox C1 

Den fabriksinställda standardkonfigurationen av Nox C1 anges i nedanstående tabell. 

Nätverkskonfigurationen av Nox C1 kan utföras via Noxturnal. 
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Nätverkskonfiguration av Nox C1 Detaljer 

DHCP-server DHCP-pool: 192.168.101.64 - 192.168.135.128 

Statisk IP-adress 192.168.101.10 

Universell Plug and Play (UPnP)-

avkänning 

Nätverksprotokoll som medger att Nox C1 upptäcks i ett 

nätverk  

För att hantera nätverkskonfigurationen av Nox C1 kan du öppna ett onlinerum som har konfigurerats 

(Devices > Online Rooms… (Enheter > Onlinerum...)) och välja Nox C1 i rummet. Klicka sedan på Edit 

Device (Redigera enhet). I nedanstående dialog kan du se hur du kan ändra nätverkskonfigurationen 

för Nox C1.  

 

Integration av videoenheter för onlineregistreringar  

Noxturnal stöder videoregistrering online. För att använda det stöd för digital video som finns i 

Noxturnal i en onlineregistrering måste du konfigurera ditt onlinesystem så att det innehåller en 

videoenhet. 

En videoenhet kan läggas till i onlinesystemet, och inställningen sparas för framtida bruk. För att 

konfigurera en videoenhet i ditt onlinesystem måste du: 

1. Se till att du har rätt videokodek (videokod) installerad på din dator 

2. Se till att videoenheten är ansluten till samma nätverk som Nox C1 åtkomstpunkt/BlueGiga, 

och att datorn kör Noxturnal  

3. Skapa ett onlinerum som innehåller videoenheten 
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4. Skapa en registreringstyp som innehåller videoenheten och definierar videoprofilen  

5. Välja onlinerummet och starta en onlineregistrering från sidan Recording (Registrering) i 

Noxturnal 

Skapa ett onlinerum med en videoenhet 

VIDEOKODER 

Noxturnals stöd för video styrs av de videokoder som är installerade i ditt datorsystem. Dessa 

videokoder är specialprogram som möjliggör komprimering och dekomprimering av digital video. 

Noxturnal installerar inte några koder, men de flesta datorsystem har några typer av koder 

installerade. Du måste ha sådana koder installerade i systemet för att kunna använda video med 

Noxturnal. Noxturnal kommer då att ge dig tillgång till de funktioner som dessa koder stöder. Du kan 

ladda ned K-Lite Codec Pack från Nox supportwebbplats: http://support.noxmedical.com/hc/en-

us/articles/207882176  

INTEGRERA EN VIDEOKAMERA 

För att skapa en onlineregistrering med en videoenhet gör du enligt nedan. 

1. Skapa ett onlinerum från Noxturnal på det sätt som förklaras i avsnittet Onlinerum (Devices > 

Online Rooms… (Enheter > <Onlinerum...) från verktygsfältet i Noxturnal).  

 

2. Lägg till en videoenhet i ditt onlinerum genom att klicka på Add Devices (Lägg till enheter) 

och välja Video Device (Videoenhet) i listan Device Types (Enhetstyper).  

http://support.noxmedical.com/hc/en-us/articles/207882176
http://support.noxmedical.com/hc/en-us/articles/207882176
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3. Då öppnas dialogen Device Properties (Enhetsegenskaper) nedan. Markera tillämpligt 

alternativ, beroende på vilken videoenhet som används, och klicka på Next (Nästa). 

 

För att ställa in din IP-kamera klickar du på Find... (Sök...), så söker Noxturnal igenom ditt nätverk och 

hittar anslutna videokameror, förutsatt att de har UPnP (ett nätverksprotokoll som gör det möjligt att 

hitta IP-kameran i nätverket) aktiverat. Noxturnal erbjuder standardanslutningsalternativ för vissa IP-
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kameror (Axis- och D-Link-kameror). När du väljer den anslutningssträng som är tillgänglig i Noxturnal 

måste du se till att välja anslutningssträngen (URL) för den registrering du ska utföra, om endast video 

ska spelas in eller om både video och ljud ska spelas in.  

Om din kamera inte hittas automatiskt av Noxturnal när du använder funktionen Find... (Sök...), kan du 

alltid lägga till din kamera manuellt genom att ange dess relevanta anslutningssträng (URL) och 

kamerans IP-adress i fältet File or URL (Fil eller URL).   

 

Om du har en videoenhet av en annan typ än Axis eller D-Link kan du alltid lägga till nya 

anslutningssträngar (URL) manuellt, så att de blir tillgängliga för framtida bruk i Noxturnal. Det gör du 

genom att bläddra till Tools > Settings > Advanced (Verktyg > Inställningar > Avancerat) och välja 

Default Settings (Standardinställningar). Öppna katalogen Video Profiles (Videoprofiler) och öppna 

Excel-bladet IPCameras (IP-kameror). Du kan lägga till en ny anslutningssträng till din videoenhet i den 

befintliga listan över anslutningssträngar, så blir den tillgänglig för användning i Noxturnal.  

När du har angett användarnamn och lösenord för din kamera kan du klicka på Start Preview (Starta 

förhandsgranskning) för att se om din kamera är korrekt inställd och fungerar med Noxturnal. Om en 

fördröjning observeras under förhandsgranskningen kan en fördröjningsinmatning läggas till för att 

korrigera videouppspelningen under analysen. Klicka på Next (Nästa) så kan du ge kameran ett unikt 

namn. Klicka sedan på Finish (Slutför).  
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Du har nu lagt till videoenheten i ditt onlinerum.  

Skapa en registreringstyp med en videoenhet 

Noxturnal erbjuder standardregistreringstyper för onlineregistreringar med en videoenhet. Du kan 

välja en av standardregistreringstyperna och direkt starta en onlineregistrering med en videoenhet. 

Du kan också skapa en anpassad registreringstyp och definiera vilken Windows-mediaprofil som ska 

användas med Noxturnal vid registrering och komprimering av onlinevideon. Det gör du genom att 

navigera till Devices > Recording Types... (Enheter > Registreringstyper...) från verktygsfältet i 

Noxturnal. I guiden Recording Types (Registreringstyper) väljer du New (Ny) och Online i listrutan 

Recording Type (Registreringstyp). 
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I guiden Online Recording Type (Onlineregistreringstyp) kan du lägga till din videoenhet precis som 

andra enheter. Du kan välja vilken videoprofil som ska användas i listrutan, se nedanstående bild.  
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Noxturnal erbjuder ett antal standardvideoprofiler, men du kan också skapa anpassade profiler och 

använda dem i Noxturnal. Läs om Windows-mediaprofiler i Noxturnal på Nox supportsida för mer 

information och instruktioner för hur du gör detta. 

Du har nu konfigurerat ditt onlinesystem så att det innehåller en videoprofil och kan starta en 

onlineregistrering från sidan Recording (Registrering) i Noxturnal, genom att dubbelklicka på rummet 

eller klicka på Configure Recording (Konfigurera registrering).  
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Köra Noxturnal  

I detta avsnitt beskrivs hur du kör och arbetar med registrerade data i Noxturnal. 

Sida för registrerade resultat  

Efter att du laddat ned från en registreringsenhet eller öppnat en befintlig registrering i Noxturnal 

visas sidan Recording Results (Registreringsresultat). Denna sida innehåller en översikt av de 

vanligaste analysparametrarna och de registrerade signalerna. Resultatsidan uppdateras automatiskt 

när ändringar görs av den befintliga poängsättningen eller om den automatiska analysen körs. När 

sömnstadier är tillgängliga, t.ex. för registreringar som gjorts med Nox A1-enheten, ser du grafer och 

information tillsammans med informationen. För Nox T3-enheten ser du bara de parametrar som är 

tillgängliga med den enheten. 

 

Kommandon på resultatsidan 

På resultatsidan finns knappar för följande åtgärder: 

 Close Recording (Stäng registrering): Detta alternativ stänger den aktiva registreringen och 

återvänder till antingen registreringsbiblioteket eller registreringssidan. 

 View Signals (Granska signaler): Detta alternativ väljer det första tillgängliga signalbladet där 

du kan bläddra igenom de registrerade signalerna, granska automatiskt poängsatta händelser 

och redigera poängsatta händelser manuellt. 

 View Report (Visa rapport): Detta alternativ skapar en standardrapport över registreringen 

med den rapport som definierats i registreringstypen (mer information finns i avsnittet 

Registreringstyper). 

 Print Report/Result Page (Skriv ut rapporten/resultatsida): Detta alternativ skriver ut 

standardrapporten och/eller sidan med registreringsresultat. 
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 Recording Status (Registreringsstatus): Detta alternativ gör att du kan ställa in status för 

registreringarna. Nedladdade registreringar har alltid status New (Ny). Om en registrering har 

misslyckats av någon anledning kan statusen ställas in på Invalid (Ogiltig). Om registreringen 

har diagnosticerats kan statusen ställas in på Scored (Poängsatt). Om registreringen och 

poängsättningen har granskats kan statusen ställas in på Reviewed (Granskad). Om 

registreringen har tolkats kan statusen ställas in på Interpreted (Tolkad). Om en registrering 

har diagnosticerats och accepterats kan statusen ställas in på Done (Klar). 

 Play Audio (Spela upp ljud): Om registreringen innehåller ljud kan knappen Play Audio (Spela 

upp ljud) användas för att spela upp ljudet. Du kan också använda mellanslagstangenten för 

att spela upp eller göra paus i ljuduppspelningen. 

Patientinformation 

Panelen Information visar information om den registrerade patienten. Redigera 
registreringsegenskaperna och patientinformationen genom att välja länken Edit (Registrera) eller 
trycka på snabbkommandot Ctrl+I. 

 
 

Sömnparametrar 

Panelen Sleep Parameters (Sömnparametrar) visar de huvudsakliga analysparametrarna och deras 

relation till allvarlighetsgraden. AHI, apnéhypopnéindex, är antalet apnéer och hypopnéer per 

sömntimme, och ODI är antalet poängsatta fall i syrgasmättnaden per sömntimme (den automatiska 

standardanalysen poängsätter alla desaturationer på 3 % eller högre, men detta kan anpassas av 

användaren). Allvarlighetsgraden går från Normal → Mild → Moderate  (Måttlig) → Severe (Svår) och 

överensstämmer med de nivåer som fastställts av AASM. Om mer än en natt har registrerats visar 

dessa parametrar genomsnittsvärdena för samtliga nätter. Se avsnittet Analysprotokoll för mer 

information. 
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Signalöversikt och parametrar 

Panelen Signal Overview (Signalöversikt) är ett granskningsverktyg med ovanifrånperspektiv, där 

registreringsresultaten kan granskas och redigeras på ett effektivt sätt. Översiktspanelen är indelad 

med analysparametrarna till höger och signalöversikten till vänster. 

 

Analysparametrarna visar en sammanfattning av de vanligaste analysparametrarna, t.ex. Hypnogram 

eller Total Sleep Time (Total sömntid), AHI etc. för en enstaka natt. Om mer än en natt har 

registrerats visar varje natt på en egen panel. Du kan också välja vilken period du vill granska i 

periodmenyn, som sitter i programmets nedre högra hörn. Varje parameter är färgkodad baserat på 

dess allvarlighetsgrad, från grönt till rött (Normal → Mild → Moderate (Måttlig) → Severe (Svår)). 

 Arousal Index (Uppvakningsindex) är antalet uppvakningar per timme under sömntiden. 

 Sleep Onset Latency (Insomningslatens) är tiden i minuter från Lights out (Släckning) 

(analysens starttid) till den första perioden av poängsatt sömn 

 REM Onset Latency (REM-sömnlatens) är tiden i minuter från den första förekomsten av 

sömn till den första förekomsten av REM. 

 Sleep Efficiency (Sömneffektivitet) sträcker sig från 0–100 %, där 0 % betyder att patienten 

var vaken hela natten och 100 % betyder att patienten sov hela natten. När 

sömnpoängsättning inte är tillgängligt använder programmet rörelseperioder för att göra en 

uppskattning av denna parameter. 

 Total Sleep Time (Total sömntid) är den tid som patienten sov. 

 När Total Sleep Time (Total sömntid) inte är tillgänglig är Est. Total Sleep Time (Uppskattad 

total sömntid) den parameter som används. Detta är den tid som patienten ligger ned under 

registreringen. Den gröna färgkoden (normal) visas om patienten ligger ned i mer än 6 

timmar. 

 Andningen visas i form av index. Index är en metod att visa analysparametrarna på ett 

standardiserat sätt. 

o Apnéhypopnéindex (AHI) 

o Apnéindex (AI) 

o Hypopnéindex (HI) 
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o Oxygen Desaturation Index (Syrgasmättnadsindex, ODI) visar antalet 

syrgasdesaturationshändelser per timme av Total sömntid, alternativt Uppskattad 

total sömntid. 

o Snore Percentage (Procentandel snarkning) är den andel av sömntiden som ägnades 

åt snarkningsepisoder (markeras som Snore Trains (Snarkningskedjor)) 

o Average dB (Genomsnittlig dB) är de genomsnittliga dB-nivåerna under perioder 

med snarkningskedjor. 

 Övergripande Signal Quality (Signalkvalitet) fastställs genom övervakning av signalkvaliteten 

på följande signaler: oximeter, luftflöde, abdominella eller torakala andningsförsökssignaler. 

Den lägsta signalkvaliteten på dessa signaler visas som övergripande Signal Quality 

(Signalkvalitet) på sidan över registreringsresultat och visas från 0–100 %. 

Signaler och händelser 

Signal- och händelsediagrammet på signalöversiktspanelen ger en översikt över hela natten. 

 Signalerna i översikten kan omfatta: 

o Spectrogram (Spektrogram) för den kanal som visas på skärmen 

o Arousals/Hypnogram (Uppvaknanden/Hypnogram) visar uppvaknandena och 

sömnstadierna under hela natten 

o Sleep Time (Sömntid) 

o Movement (Rörelse) 

o Position 

o Apneas/RIP Phase (Apnéer/RIP-fas) (fasen mellan andningsförsökssignaler från 

buken och torax) 

o Oxygen Desaturation (Syrgasdesaturation, SpO2) 

o Pulse (Puls) 

o Audio Volume (Ljudvolym) (Snarknings-dB)  

o Leg Movements (Benrörelser) (valfritt) 

 Händelser som visas på översikten omfattar apnéer och hypopnéer, fall i syrgasmättnaden, 

snarkningsepisoder och artefakter. 

Om du för musen över ikonerna för Uppvaknanden/Hypnogram, Sömntid/Rörelse/Position, 

Apnéer/RIP-fas, O2-desaturation och Puls visas fler detaljer om respektive signal eller händelse. 
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Ändra analysperioder 

Om en registrering börjar innan alla sensorer har anslutits eller om patienten avlägsnar sensorerna 

innan registreringen avslutas kan man justera det intervall som analyseras genom att flytta 

markörerna för analysstart  och analysslut  till lämpliga positioner i registreringen. Samtliga 

analysparametrar uppdateras på motsvarande sätt när dessa justeringar görs. 

 

För att navigera i registreringen använder du synkroniseringsmarkören . Samtliga signalblad, t.ex. 

bladen för PSG, Respiratory (Andning) och Pulse Oximeter (Pulsoximeter) synkroniseras på 

motsvarande sätt. Om det finns en intressant händelse i översikten kan du dra 

synkroniseringsmarkören över det området och bläddra till relevant signalblad för att granska 

råsignalerna.  

Händelseperioder kan läggas till direkt från panelen Signal Overview (Signalöversikt). För att lägga till 

en händelseperiod klickar du på panelen Periods (Perioder). Menyn Event period (Händelseperiod) 

blir tillgänglig, så som visas nedan.  

 

Sömnpoängsättning och uteslutande av ogiltiga data kan göras på panelen Signal Overview 

(Signalöversikt). För att poängsätta sömnen eller utesluta ogiltiga data från registreringen klickar du 

på panelen Periods (Perioder) och väljer ett område genom att dra åt vänster/höger. Släpp 

musknappen så blir nedanstående meny tillgänglig. Händelserna "Awake" (Vaken) och "Invalid Data" 

(Ogiltiga data) utesluts från rapportberäkningarna. 
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Ställa in enheter 

För att ändra vilka enheter som används för att visa värden för exempelvis längd och vikt navigerar du 
till Tools > Settings… (Verktyg > Inställningar) från verktygsfältet i Noxturnal. På egenskapssidan 
General (Allmänt) letar du upp listrutan System Units (Systemenheter) och väljer tillämpliga fält för 
redigering. 
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Granska signaler 

Menyknappen Arbetsyta 

Menyknappen Workspace (Arbetsyta) låter dig använda olika layouter på arbetsytan och signalbladen 

för att bestämma hur du vill se dina registreringar. Layouterna för arbetsyta inbegriper val av 

signalblad och signalbladens egenskaper. Noxturnal erbjuder ett antal standardlayouter för 

arbetsytan (layouterna Respiratory (Andning) och PSG) samt signalbladen. Du kan också skapa 

anpassade layouter för arbetsytan och signalbladen. Du kan spara alla ändringar du gör av din 

arbetsytas layout för framtida användning. Det innebär att du kan ändra inställningarna för spår och 

skapa din egen arbetsmiljö som du vill. 

 

Från menyknappen Arbetsyta kan du välja Add Sheet (Lägga till blad), New Workspace Layout (Ny 

layout för arbetsyta), skapa en ny layout från en standardlayout eller välja Revert Layout (Återställ 

layout) efter att du gjort ändringar. 

 

För att spara ett anpassat signalblad högerklickar du på signalbladets flik och väljer Save Sheet Layout 

As...  (Spara bladets layout som...) När du har sparat det anpassade signalbladet kan du alltid använda 

Update Saved Layout (Uppdatera sparad layout) om fler ändringar görs. Se avsnittet Signalblad för 

mer information om signalblad. 
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Signalblad 

Ett signalblad visar en eller flera signaler i ett flikfönster på arbetsytan. Noxturnal har fördefinierade 

signalblad, t.ex. bladen för Respiratory (Andning), PSG och Pulse Oximeter (Pulsoximeter). 

För att lägga till eller ta bort signaler på ett signalblad navigerar du musen till åtgärdsfönstret Signals 

and Data (Signaler och data) som finns till höger på arbetsytan. När du för musmarkören över denna 

flik öppnas åtgärdsfönstret Signaler och data. I detta åtgärdsfönster visas en lista över samtliga 

tillgängliga signaler. En kryssruta bredvid signalen avgör om signalen visas på bladet eller inte. 

Markera/avmarkera rutan för att lägga till eller ta bort signalen från bladet. Se fliken Signals & Data 

(Signaler och data) här nedan. 
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Arbeta med signaler 

 

Med hjälp av navigeringsfältet kan du snabbt navigera till valfri tidpunkt i registreringen. Den blå 

linjen visar var användaren befinner sig i registreringen. Klicka på valfri plats i fältet för att hoppa 

till den tidpunkten. 

Tidsaxeln visar registreringstiden och tidsperiod i fönstret. Högerklicka på tidsaxeln för att ändra 

intervallet i fönstret. Du kan tänja ut/komprimera tidsaxeln med musen för att ändra 

tidsintervallet i fönstret. 

Synkroniseringsmarkören på tidsaxeln används för att synkronisera med andra signalblad och 

vyer. Klockan på höger sida i navigeringsfältet visar tidpunkten vid markörens position. 

Synkroniseringsmarkören kan dras och flyttas längs tidsaxeln. 
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Signalvärdeaxeln visar namnet på motsvarande plottade signal och värdeaxelns skala. Denna 

axel kan tänjas ut/komprimeras med musen. För att ändra värdeaxelns egenskaper dubbelklickar 

du på axeln. Då öppnas en dialog där egenskaperna kan ändras. 

Signaler plottade på en panel. Signalerna kan justeras på många sätt. Du kan ändra 

signalpanelens storlek eller flytta omkring den med musen. För att ändra signalens egenskaper 

dubbelklickar du på signalen. Då öppnas en dialog där signalens egenskaper kan ändras. För att 

komma åt samtliga åtgärder för ett enskilt signalspår högerklickar du på signalspåret. Då blir 

följande meny tillgänglig. 

 

Navigera med tangentbordet 

Du kan navigera på och manipulera signalbladet med följande snabbkommandon: 
 
Navigering: 

 Högerpil = Som standard - Gå en halv sida framåt. Kan konfigureras av användaren 

 Vänsterpil = Som standard - Gå en halv sida bakåt. Kan konfigureras av användaren 

 Ctrl + högerpil = Som standard - Gå en hel sida framåt. Kan konfigureras av användaren 

 Ctrl + vänsterpil = Som standard - Gå en hel sida bakåt. Kan konfigureras av användaren 

 Tangenten Page Down = Gå en sida framåt 

 Tangenten Page Up = Gå en sida bakåt 

 Tangenten Home = Registreringens början 

 Tangenten End = Registreringens slut 

 Shift + högerpil = Ökar tidsintervallet i fönstret 

 Shift + vänsterpil = Minskar tidsintervallet i fönstret 

 Shift + Ctrl + vänsterpil = Hoppa till föregående datasession 

 Shift + Ctrl + högerpil = Hoppa till nästa datasession 

 Tangenten - = Zooma ut ur urvalet 

 Tangenten + = Zooma in i urvalet 
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 Mushjulet = Bläddra framåt/bakåt 

 Mushjulet + tangenten Ctrl = Bläddra uppåt och nedåt 

Aktiv signal: 

 Shift + uppåtpil = Öka signalskalan 

 Shift + nedåtpil = Minska signalskalan 

 Ctrl + uppåtpil = Skifta signalen uppåt 

 Ctrl + nedåtpil = Skifta signalen nedåt 

 Shift + Retur = Visa aktiv signal på ett nytt blad 

 Shift + Delete = Ta bort aktiv signal från bladet 

 Uppåtpil = Välj signalen ovan 

 Nedåtpil = Välj signalen nedan 

 Ctrl + F = Sök händelser 

 F9 = Ändra signalens skala automatiskt 

Signalblad: 

 Mellanslag = Spela upp/pausa uppspelningen av registreringen 

 Ctrl + W = Ändra signalens skala automatiskt 

 Ctrl + A = Arrangera signalerna 

Händelser: 

 Tabb = Nästa händelse, eller nästa sökresultat vid sökning 

 Shift + tabb = Föregående händelse, eller föregående sökresultat vid sökning 

 Delete = Radera valda händelser eller radera händelser som överlappar urvalet 

 Retur = Avmarkera alla händelser 

 Esc = Ta bort alla val 

Arbeta med händelser  

Händelser används för att identifiera intressanta områden i en signal. En händelse har en start- och en 

sluttid och klassificeras med en typ. Händelserna kan antingen läggas till en signal manuellt eller 

poängsättas av den automatiska analysen för att flagga intressanta områden. Händelser kan 

modifieras eller tas bort. 

Poängsätta en händelse 

För att poängsätta en händelse går du till ett blad som innehåller signaler och letar upp ett område på 

en signal. 

 Markera ett område att poängsätta händelsen utifrån med vänster musknapp. 

 Tryck på snabbkommandot för den händelsen. För att visa en lista över snabbkommandon för 

poängsättning, gå till Edit > Configuration > Scoring Shortcut Keys… (Redigera > Konfiguration > 

Snabbkommandon för poängsättning...) i verktygsfältet i Noxturnal. 
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En alternativ metod för att poängsätta en händelse är att markera ett område med vänster musknapp 

som förut, men därefter högerklicka på området och välja en händelse i listan. 

Poängsättning med ett enda klick 

Noxturnal erbjuder möjlighet att använda Single Click Scoring (poängsättning med ett enda klick). För 

att aktivera funktionen poängsättning med ett enda klick så klickar du på ikonen        i verktygsfältet i 

Noxturnal.  

 

Poängsätt en händelse manuellt på relevant signalspår på tillämpligt signalblad. Instruktioner om hur 

du poängsätter en händelse manuellt finns i avsnittet Poängsätta en händelse ovan. När du har 

poängsatt den första händelsen ger enkelklicksfunktionen dig möjlighet att fortsätta med 

poängsättning av samma typ av händelse med endast ett musklick när du bläddrar genom 

registreringen 

. 

Radera en händelse 

Det finns flera sätt att radera befintliga händelser: 

 Välj en händelse genom att vänsterklicka på den och tryck sedan på tangenten Delete. 

 Högerklicka på en händelse och välj Remove Event (Ta bort händelse). 

 Välj ett område med musen som omfattar händelserna som ska raderas och tryck på 

tangenten Delete. 
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Flytta en händelse 

För att flytta en händelse till en annan plats väljer du händelsen genom att hålla ned vänster 

musknapp och sedan dra händelsen till önskad plats. Händelser kan dras både mellan signaler och till 

en annan tidsperiod. 

Ändra storlek på en händelse 

För att ändra storlek på en händelse flyttar du musmarkören över händelsens vänstra eller högra 

gräns. Musmarkören ska ändras till en ikon i form av en pil som pekar åt höger och vänster. Så snart 

ikonen har ändrats till en pil vänsterklickar du och drar händelsen till önskad varaktighet. 

Navigera i händelser 

Det finns flera sätt att navigera i poängsatta händelser i registreringen: 

 Hoppa mellan de händelser som har poängsatts på en signal genom att klicka på signalen och 

trycka på tangenten Tabb. Då hoppar du till nästa händelse i tiden. För att hoppa till 

föregående händelse i tiden trycker du på tangenterna Shift + Tabb. 

 I det övre högra fönstret i arbetsytan finns en sökruta där du kan söka efter händelser som 

har poängsatts. När du klickar i textrutan visas en lista över alla händelsetyper som har 

poängsatts. För att söka efter händelser av en viss typ klickar du på den händelsetypen i 

listan. Då visas nästa händelse i tiden av denna typ. Klicka på navigeringsknapparna i listrutan 

för att navigera till händelserna. 

 Välj View > Event Overview (Visa > Händelseöversikt) i verktygsfältet i Noxturnal för att 

öppna ett översiktsfönster som visar samtliga händelser som har poängsatts i registreringen i 

ett diagram. För att navigera till en viss händelse klickar du på den i översiktsdiagrammet. 
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Analysprotokoll 

Ett analysprotokoll är en uppsättning detektorer som kan köras på registreringen för att hitta och 
markera olika händelser i de registrerade signalerna. Tillgängliga analysprotokoll, inklusive 
standardprotokollen, finns under menyn Analysis (Analys). För att köra ett analysprotokoll på 
registreringen väljer du tillämplig analys i menyn Analysis (Analys) och klickar på den. 

Noxturnal erbjuder ett antal standardanalysprotokoll och du kan även skapa ett nytt analysprotokoll 

med anpassade inställningar och/eller detektorer. För att skapa ett anpassat analysprotokoll går du till 

Analysis > Manage Protocols (Analys > Hantera protokoll) i verktygsfältet i Noxturnal. Du kan välja 

Edit (Redigera) och Rename (Byt namn) för ett befintligt protokoll eller New based on (Nytt baserat 

på) för att skapa ett nytt protokoll från ett befintligt protokoll. 

  

I detta exempel kommer vi att skapa ett nytt analysprotokoll. Välj New (Nytt) i dialogen Manage 

Analysis.  (Hantera analyser). Ett nytt blad för Analysis Protocol (Analysprotokoll) öppnas, där det nya 

protokollet kan definieras. Ett protokoll består av en uppsättning detektorer. En detektors funktion är 

att hitta intressanta områden i en signal och poängsätta områden som innehåller händelser.   

För att lägga till en detektor till protokollet väljer du detektorn i listan Detectors (Detektorer) och 

väljer Add Detector>> (Lägg till detektor). General Properties (Allmänna egenskaper) och Input Signal 

(Inmatningssignal) kan redigeras.   
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När du har skapat ditt analysprotokoll klickar du på Save and Close (Spara och stäng). Protokollet 
läggs till i listan över tillgängliga analyser.  

Arbeta med poängsättningar  

En poängsättning är en uppsättning händelser som har poängsatts på signalerna i registreringen. 

Åtgärderna för att arbeta med poängsättningar finns under knappen Scoring (Poängsättning) i 

verktygsfältet i Noxturnal. De åtgärder som du kan använda när du arbetar med poängsättningar 

anges i nedanstående avsnitt.  

 

Om du har tagit med ett analysprotokoll i den registreringstyp som konfigurerats för registreringen 

kommer Noxturnal automatiskt att använda standardanalysprotokollet för att analysera 

registreringen när du laddat ned den från en Nox registreringsenhet. För onlinestudier måste du 

stänga registreringen när den är klar. När den sedan öppnas igen från registreringsbiblioteket kommer 

den analyseras med standardanalysen. Den automatiska dataanalysen skapar en ny poängsättning 

som kallas för Untitled Scoring (Namnlös poängsättning), se skärmdump ovan. Under knappen 
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Scoring (Poängsättning) ser du alltid vald poängsättning som används för rapporteringens och 

registreringens översiktsfunktioner. Du kan enkelt skapa nya poängsättningar genom att använda 

funktionerna under knappen Scoring (Poängsättning). Om du t.ex. gör ändringar av den automatiska 

poängsättningen så kan du enkelt spara den som en ny poängsättning under lämpligt namn. 

 

Från knappen Scoring (Poängsättning) kan du också välja Add Event Period (Lägg till händelseperiod) 

eller Add Tech Note (Lägg till teknisk not) för registreringen. 

Ny poängsättning 

När du använder enheter som registrerar EEG kan du använda sömnstadiefunktionerna i Noxturnal. 

Noxturnal erbjuder automatisk sömnstadieindelning i systemet, men det är även möjligt att göra 

detta manuellt.  

Manuell indelning i sömnstadier utförs genom att man använder knappen Scoring (Poängsättning) för 

att välja New Scoring (Ny poängsättning). 
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Därefter kan du starta indelningen i sömnstadier genom att välja åtgärden Start Sleep Staging (Starta 

indelning i sömnstadier) från menyn under knappen Scoring (Poängsättning). Knappsatsen på 

tangentbordet används som snabbkommandon för standardindelningen i sömnstadier. Du kan ändra 

snabbkommandona för poängsättning enligt nedan. 

Knappen Scoring (Poängsättning) används även för att starta Bio Calibration (Biologisk kalibrering). 

Välja en poängsättning 

Flera poängsättningar kan förknippas med en och samma registrering. Alla tillgängliga 

poängsättningar finns i en lista på panelen Scorings (Poängsättningar). Välj aktiv poängsättning genom 

att klicka på den. 

Spara poängsättning 

Spara aktiv poängsättning genom att klicka på alternativet Save Scoring (Spara poängsättning). 

Användaren uppmanas ge den sparade poängsättningen ett namn. Den sparade poängsättningen 

läggs till i listan över poängsättningar. 

Ta bort poängsättning 

Om en poängsättning är aktiv tas den bort genom denna åtgärd. Om den aktiva poängsättningen har 

modifierats lokalt kommer användaren att bli uppmanad att ange om de lokala ändringarna ska 

sparas. 

Återställa poängsättning 

Om en poängsättning har lokala ändringar som inte har sparats kan dessa ändringar ångras. Detta 

innebär att poängsättningen återställs till det tillstånd den var i innan den lästes in. 
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Radera vald poängsättning 

En sparad poängsättning kan raderas genom att välja den i listan över poängsättningar och klicka på 

alternativet Delete Selected Scoring (Radera vald poängsättning). Ett meddelande visas som frågar 

om poängsättningen kan raderas. 

Snabbkommandon för poängsättning 

Ett snabbkommando används för att snabbt poängsätta händelser. För att visa en lista över befintliga 

snabbkommandon för poängsättning eller ändra snabbkommandona, gå till Edit > Configuration > 

Scoring Shortcut Keys… (Redigera > Konfiguration > Snabbkommandon för poängsättning...). 

En tumregel är att händelser bara bör ha ett enda tecken på tangentbordet som snabbkommando, 

men en kombination av Ctrl, Shift och Alt plus ett tecken på tangentbordet stöds. 

Rapporter i Noxturnal  

Noxturnal erbjuder ett antal standardrapporter som du når genom att klicka på menyn Reports 

(Rapporter) i verktygsfältet i Noxturnal. Standardrapporterna i Noxturnal kommer från två olika källor. 

Vissa är inbyggda i det så kallade nya rapportsystemet (implementerat i Noxturnal 4.x), och andra är 

inbyggda i det äldre rapportsystemet i Noxturnal och kallas för Legacy (Klassiska) rapporter. Vi 

rekommenderar starkt att användarna använder det nya kraftfulla rapportsystemet för att kunna 

redigera och anpassa rapporter på ett enkelt sätt. Instruktioner för hur du anpassar rapporterna i det 

nya rapportsystemet finns i avsnittet Anpassa rapporter nedan. 

Det är viktigt att användarna är medvetna om att det finns vissa skillnader mellan mekanismerna i det 

nya rapportsystemet i Noxturnal och de klassiska rapporterna. Nedan följer några förklaringar av 

skillnaderna mellan rapportsystemen: 

 Det finns en skillnad i hur position och aktivitet beräknas. I nedanstående tabell anges de 

olika beräkningarna för parametrarna för position och aktivitet i de klassiska rapporterna och 

det nya rapportsystemet. 

Rapporter i Noxturnal: Beräkning av position och aktivitet 

Nya rapportsystemet 
Position och aktivitet beräknas från sömnperiod (PSG) 

eller uppskattad sömnperiod (PG) 

Klassiska rapporter Position och aktivitet beräknas från hela natten 

I det nya rapportsystemet bifogas total sömntid (TST), t.ex. "Supine Time (in TST) (Supin tid 

(under TST)" till parametrarna för position och aktivitet. I de klassiska rapporterna skulle det 

bara stå "Supine Time" (Supin tid). 

 I de klassiska rapporterna beräknas kvalitetsindex från den period som valdes vid 

granskningen av registreringarna (valet kan göras i informationsfältet i det nedre högra 

hörnet i Noxturnal). Om vald period är "Whole Recording" (Hela registreringen) påverkas inte 

kvalitetsindex i rapporterna när man ändrar start- och stopptid för analys av registreringen. 
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Om vald period är "Analysis" (Analys) uppdateras kvalitetsindex utifrån vald analysperiod. I 

det nya rapportsystemet är kvalitetsindex alltid beroende av analysperioden. 

 

 Rapportresultaten är fasta och uppdateras inte när analysen av registreringen 

ändras. 

 Om ändringar görs av analysen kan en ny rapport skapas eller den befintliga 

rapporten uppdateras. 

Skapa rapporter 

När du har skapat en rapport i det nya rapportsystemet kan du enkelt ändra den med knappen Edit 

(Redigera) som visas i verktygsfältet när du granskar rapporter. 

 

Knappen Edit (Redigera) öppnar redigeringsläget där du kan redigera rapporten på samma sätt som i 

Microsoft Word®. Alla ändringar du gör blir omedelbart synliga. Du kan också lägga till nya index och 

även fördefinierade rapportdelar när du tolkar en studie. För att stoppa redigeringsläget trycker du på 

knappen Edit (Redigera) igen. Ändringar som görs i redigeringsläget sparas inte som en del av 

rapportmallen.  
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Anpassa rapporter 

Noxturnal erbjuder ett kraftfullt system för anpassade rapporter som omfattar redigeringsmöjligheter 

som liknar dem i Microsoft Word®. Rapporterna i Noxturnal är enkla att anpassa. För att skapa en 

anpassad rapportmall gör du enligt nedan. 

1. I verktygsfältet i Noxturnal väljer du Reports > Manage Reports… (Rapporter > Hantera 

rapporter...) 

2. I dialogen Manage Reports (Hantera rapporter) väljer du ett av alternativen Edit (Redigera), 

New (Ny) eller New Based On (Ny baserad på) utifrån vad du vill göra. 

 
 

3. I detta exempel kommer vi att skapa en anpassad rapport baserad på standardrapporten PSG 

Report [AASM 2013]. Välj PSG Report [AASM 2013] i listan över tillgängliga rapporter och 

klicka på New Based On (Ny baserad på). 

4. Du ser då följande dialog, där du kan ge den nya rapportmallen ett namn och därefter välja 

Create (Skapa). 

 
5. Ett nytt blad öppnas med standardrapporten PSG Report [AASM 2013] där du kan redigera 

rapporten. På höger sida av skärmen finns ett antal Fields (Fält) och Report Parts 
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(Rapportdelar) som du kan använda i din rapport. Se avsnittet Rapportdelar och rapportfält 

nedan för mer information om rapportdelar och fält. 

 
Obs! I rapportmallen kan du hålla musmarkören över fälten (-) för att se detaljer om 

parametrarna. Se nedanstående figur. 

 

RAPPORTDELAR OCH RAPPORTFÄLT 

Varje rapportdel utgör ett avsnitt i din rapport, som exempelvis Oximetry Saturation (Syrgasmättnad), 

PLM Details (PLM-detaljer) etc. Rapportdelar och fält kan skapas i Noxturnal, och du kan spara 

rapportdelar från standardrapporterna så att du kan använda dem när du skapar helt nya rapporter. 
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SKAPA EN NY RAPPORTDEL 

Du kan skapa nya rapportdelar och spara dem för framtida bruk. Det gör du genom att välja tillämplig 

rapportdel i rapportmallen (eller valfri anpassad text/tabell som du skapat), och dra och släppa den i 

listan Report Parts (Rapportdelar). Ge rapportdelen ett namn och välj kategori. Den nya rapportdelen 

du skapat läggs till i listan Report Parts (Rapportdelar). 
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SKAPA ETT NYTT RAPPORTFÄLT 

Du kan skapa nya rapportfält och spara dem för framtida bruk. Det gör du genom att följa 

nedanstående steg. 

1. I detta exempel kommer vi att välja ett standardfält som finns i Noxturnal-rapporten 

Desat Drop ≥ 4% Count som utgångspunkt för vårt anpassade fält. Välj rapporten Desat 

Drop ≥ 4% Count och klicka på New Based On (Ny baserad på). 
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2. I dialogen Edit Report Field (Redigera rapportfält) ger du det nya fältet ett namn och 

redigerar dess egenskaper efter behov. 

 

I detta exempel kommer vi att ändra desaturationsfallet till ≥ 3 och ge det nya fältet det beskrivande 

namnet Desat Drop ≥ 3% Count. Om förutsättningarna ska ändras klickar du på Conditions 

(Förutsättningar) för att se alla tillgängliga förutsättningar. 

LÄGGA TILL RAPPORTDELAR OCH RAPPORTFÄLT TILL RAPPORTER 

För att lägga till rapportdelar och fält i din rapport placerar du muspekaren vid önskad plats i 

rapporten och dubbelklickar för att lägga till önskad rapportdel från listan på höger sida. Ett annat sätt 

att lägga till en rapportdel och fält till en rapport är att dra och släppa önskad rapportdel/fält till din 

rapport. 

SIDHUVUDEN OCH SIDFÖTTER I RAPPORTER 

För att anpassa rapportens sidhuvud och sidfot gör du enligt nedan. 

1. I verktygsfältet i Noxturnal väljer du Tools > Settings > User & Company (Verktyg > 

Inställningar > Användare och företag) så ser du följande guide, där du kan ange 

information om användare och företag.  
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Ange tillämplig information i de fält som visas ovan. Du kan infoga information som angetts i din 

rapport med hjälp av motsvarande rapportfält.  

 

2. För att infoga informationen i rapportens sidhuvud/sidfot placerar du musmarkören i 

den övre delen av rapporten, högerklickar och väljer alternativet Edit Header/Footer 

(Redigera sidhuvud/sidfot). 

 

 

3. Lägg till tillämpliga fält från listan över tillgängliga fält i sidhuvudsområdet. 
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4. För att lägga till en logotyp i din rapport klickar du på Format > Insert Image… 

(Formatera > Infoga bild) så som visas nedan. 

 
 

5. För att lägga till sidnummer i rapporten går du längst ned på rapportsidan, högerklickar 

och väljer Edit Footer (Redigera sidfot). Högerklicka i sidfotsområdet och välj Insert > 

Page Number (Infoga > Sidnummer). 

När du är klar med din rapportmall väljer du Save.  (Spara). Din rapport läggs till i listan Report 

(Rapport) som kan nås från verktygsfältet i Noxturnal. 

Exportera rapporter 

För att exportera en rapport klickar du på Export (Exportera) rapportverktygsfältet. 

 

Då öppnas en ny dialog där du kan specificera filformatet och ange filnamnet. Klicka på Save (Spara) 

när du är klar, så sparas rapporten på hårddisken i angivet filformat. 

Skriva ut rapporter 

När en rapport har skapats kan användaren skriva ut den. För att skriva ut en rapport väljer du 

alternativet Print (Skriv ut) i rapportverktygsfältet. 

 

En dialog öppnas där du kan ändra utskriftsalternativen. Klicka på knappen Print (Skriv ut) när du har 

anpassat inställningarna. 
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Registreringsbiblioteket 

Registreringsbiblioteket visar och hanterar alla registreringar som har laddats ner från Nox 

registreringsenheter samt onlinestudier. När registreringar öppnas eller laddas ned i Noxturnal läggs 

de automatiskt till i registreringsbiblioteket. 

För att öppna en registrering väljer du den i listan i registreringsbiblioteket och dubbelklickar på den. 

Arkivera registreringar 

Registreringarna i registreringsbiblioteket kan arkiveras på en annan plats eller i ett permanent arkiv. 
För att arkivera en registrering väljer du en eller flera registreringar i biblioteket och klickar på 
knappen Archive Recording... (Arkivera registrering) i panelen med registreringsinformation. En 
dialog öppnas som leder användaren genom arkiveringsprocessen. 
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Regulatorisk Information 

Beskrivning av symboler och förkortningar  

 
 CE-märkningen anger överensstämmelse med EG-

direktiven 93/42/EG och 2007/47/EG rörande 
medicinska anordningar 

UDI: 15694311110255 VVvvrr  Unik enhetsidentifiering (UDI). De första 14 tecknen 
visar enhetsidentifieringen (DI) (”15694311110255”) 
och de sista sex visar programversionen 

(01)15694311110255(8012)VVvvr

r(11)YYMMDD(10)YYMMDD 

 Unik enhetsidentifiering (Unique Device Identifier, 
UDI), (01) utgör enhetsidentifieringen (DI) 
(“15694311110255”), (8012) programversionen, (11) 
produktionsdatum/tillverkningsdatum (”YYMMDD”, 
där ”YY” är de två sista siffrorna i produktionsåret, 
”MM” produktionsmånaden och ”DD” 
produktionsdagen) och (10) är lotnumret 
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Om 

Denna handbok tillhandahålls i elektroniskt format enligt kommissionens föreskrift (EU) nr 207/2012 

från den 9 mars 2012 om elektroniska bruksanvisningar för medicinteknisk utrustning. 

Denna handbok tillhandahålls i form av ett pdf-dokument. PDF-läsare är allmänt tillgängliga utan 

kostnad för användarna. 

Denna handbok är också tillgänglig på Nox Medicals webbplats: 

http://support.noxmedical.com/hc/en-us/articles/200863875-Noxturnal-Software-Manuals 

En papperskopia kan beställas kostnadsfritt genom att skicka ett epostmeddelande till 
support@noxmedical.com. Denna papperskopia kommer att skickas inom 7 kalenderdagar. 

http://support.noxmedical.com/hc/en-us/articles/200863875-Noxturnal-Software-Manuals

